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 ART 211  
Graphic Design Production I 
     Section 2, Tuesday/Thursday 2:30–5:00pm, NFAC 182/172

Fall Semester 2016,  Instructor: Professor Diana K B Hoover  

University of Wisconsin-Stevens Point, Department of Art & Design 

Phone: 715-346-4556   •   Email: dhoover@uwsp.edu   •   Office: NFAC 181  

Office Hours:  M/W 10:30–11:30am, and by appointment

OVERVIEW  

In this class we will study the essential aspects of 
making design work for print. Specifically, you 
will become familiar with: 

•	 processes used in design and how to 
prepare your documents for printing and 
presentation 

•	 formats of different kinds of printed pieces 
and variables in paper, materials, and 
binding 

•	 software programs used by designers —
Adobe InDesign, Illustrator, Photoshop, 
Acrobat

•	 typefaces best practices on using type, how 
to manage fonts used in your design work 

•	 images categories of illustrative, 
photographic, stylistic variations and file 
format conventions

•	 color issues and critical differences between: 
RGB, CMYK, Spot color, Builds, Pantone systems 

•	 hardware including Macs, laser/inkjet/banner 
printers, scanners, laser cutter  

COURSE WORK 

Our course content will be presented through 
exploration of materials and examples, lectures, 
demonstrations, discussions and hands-on 
learning in the computer labs. 

Each class period there will be a focus for the 
day’s Assignment. You will be provided the 
written outline of the material covered and.   

Daily: Assignments  
You are responsible for completing all of the 
daily Assignments, which reiterate the skills we’re 
learning in class. These Assignments will become 
the content for your major class project, the 
Design Skills Workbook.  

Major Project: Design Skills Workbook 
This project documents the skills we learn in class 
and all the Assignments.  

You get to design the layout, but must follow 
the specifications given. You will generate 
your own images to illustrate the topics. Text 
will be provided for you, however, you will be 
responsible for adding additional text.

Project descriptions will explain the goals, the 
required specs and how the project is graded.  
 

COURSE POLICIES

Attendance 
Come to class. Come to class on time. You will 
be marked tardy if you are more than five (5) 
minutes late. Three (3) tardies equal one (1) 
unexcused absence. You must stay for the whole 
class period. Leaving early will earn you an 
unexcused absence.

Attendance at each scheduled class is 
mandatory and you are expected to stay 
for the entire class. Coming to class without 
the required work for that day will result in an 
unexcused absence. 

Three unexcused absences lowers your semester 
grade a full letter grade. Please let me know 
about any absences you anticipate for 
legitimate reasons before they occur.

If you end up missing a class, please consult 
the syllabus and classmates to find out what 
was covered. I will gladly answer your questions 
about the missed content.

Mindset & Conduct 
Engage. Challenge yourself to do your best 
in the class work.  Participate. Cultivate good 
humor, honesty and resiliancy.  Honor. Respect 
yourself and others in class. Do your own work 
and give credit where credit is due.  Cooperate. 
Everyone does better with a spirit of generosity. 
Learn all you can and share what you learn.
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TEXTBOOK, COURSE FEES & MATERIALS 

Textbook 
This course does not have a specific textbook.  
We will use demonstrations, exercises and 
both physical and online resources to extend 
learning. 

Course Fees 
The fees for this course will be used to 
purchase some supplies and cover the basic 
cost of printing and binding your Design Skills 
Workbook. 

Materials You will need the following:
• stainless steel, cork-backed ruler 
• X-acto knife and blades 
• sketch book / notebook  
• matte board (course fees) 
• digital storage device 

EVALUATION & GRADING
Class participation is measured by how much 
you engage in the class work, discussions, 
critiques and labtime. All assignments will be 
evaluated based on timely completion and the 
quality of the work you put in to it. Grades are 
assigned according to how well you meet the 
stated technical and visual design requirements 
of the assignment. 

Assignments — See Assignment page 
Class assignments are worth 10–50 points each. 
Assignments need to be uploaded to the class 
Basecamp Space and are due on the day 
specified.  Late assignments will lose 5 points 
each day late.   
 
Design Skills Workbook — See Workbook page 
Your skills Workbook carries 50% of your grade 
in the class. A rubric is supplied to explain the 
specifications and design requirements.

At midterm you will turn in a PDF of your 
workbook for general feedback and an in-
progress grade. 

Your final workbooks will be submitted to our 
on-campus Printing & Design office for printing.  
Final workbooks must be submitted by the 
stated deadline. Late workbooks will not be 
accepted and will result in an automatic failing 
grade.  

Midterm  
You will receive a midterm in-progress grade. 
Midterm grades reflect the accumulated 
assessment of all assignments in the first half of 
the semester, and will give you an idea how 
you are doing in class.

Your final semester grade will be determined by 
the following percentages: 

	 Design Skills Workbook 		  50%
	 Assignments			   30%  
	 Participation			   20%
 
OTHER STUFF
Class Naming Convention 
Your digital files need to be saved using the 
following naming convention:
lastnamefirstinitial_211_15_projectname

Class Server Space 
We will use a class server space for turning 
in digital assignments. Each of you will make 
a folder to store your work in. Keep this 
space organized and use our class naming 
conventions. We will walk through the process 
together. 

Back up / Archive your work  
Even though you have a university digital server 
space, that is your MyFiles, you need to get in the 
habit of backing up your digital files. A flash drive 
is fine, an external hard drive may be a good 
investment.

Learn more at lynda.uwsp.edu  
The university has a subscription to lynda.com, 
an online site full of tutorials on almost any 
program you could want to learn. These tutorials 
do not replace in-class learning though they 
can deepen your understanding of a specific 
interface and general topics in design. To use 

Please Note:  
If you have concerns about meeting the requirements of this class stipulated in this syllabus, please speak with me as soon 
as possible. Let me know within the first two weeks of class if you need special accommodations to participate in this class. 
Any personal concerns communicated will be confidential. I am happy to discuss your situation with you and help you locate 
resources that may be able to provide assistance. Feel free to make an appointment to talk with me about any aspect of the 
class or the graphic design program.



COURSE SCHEDULE       ART 211 section 2			 

Month	 Day	 Topics / Activities			   Assignments Due for following classes 			 

SEPTEMBER	 H_03	 Course Overview / Orientation to Class/Lab Spaces			   Set up class folders / drawers 		   	  

		  Print Design Formats, Paper, Printing			   Assignment: Print Design, Paper, Printing 
		  Study examples in class			    

	 T_08	 Design Process, Workbook, Grid, Type, Image, Adobe CC		  Assignments: Print Design Analysis  
						            Thumbnails for layout // Begin Workbook

	 H_10	 Pages, Tools, Guides, Grids, Master Pages —InDesign			   Assignment: Pages, Tools, Guides, Grids, Master Pages  

	 T_15	 Typeface Categories, Type Basics —InDesign			   Assignment: Type I — Typeface Categories, Type Basics

	 H_17	 Typesetting, Leading, Alignment, Indents, Spacing —InDesign	 Assignment: Type II — Leading, Alignment, Indents, Spacing 

	 T_22	 Paragraph & Character Styles—InDesign 			   Assignment: Type III — Paragraph & Character Styles

	 H_24	 Type & Image, Text Wrap  / Screenshots —InDesign	  		  Assignment: Type & Image, Text Wrap, Screenshots 

	 T_29	 Color / RGB v. CMYK v. Spot Color—InDesign			   Assignment: Color Spaces & Spot Color 	   	

OCTOBER	 H_01	 Workbook Design specs / Creating PDFs —InDesign 			   Assignment: Creating PDFs / Export Workbook in progress 

 	 T_06	 Overview Illustration Kinds, File Formats —Adobe Illustrator		 Assignment: Illustration Kinds, File Formats	   	

	 H_08	 Technical Illustration —Views & Drawings / Scanner			   Assignment: Technical Illustration—on paper, scan drawing 

	 T_13	 Artboards, Tools, Layers, Image Trace, Pen Tool —Illustrator 	 Assignment: Artboards, Tools, Layers, Image Trace, Pen Tool

	 H_15	 — — no formal class meeting — work on Workbooks	 		   

	 T_20	 Develop views—Front, Side, Top, and ¾ view —Illustrator	 	 Assignment: Technical Illustration—Line drawings—digital

	 H_22 	 Color, Gradient, Gradient Mesh —Illustrator 			   Assignment: Color, Gradient, Gradient Mesh / illustration 

	 T_27	 Printing document, Trim Marks —Illustrator			   Assignment: Printing, Trim Marks in Illustrator

	 H_29	 Mounting Demo / Develop Tech Illustration final			   Assignment:Technical Illustration—printed, mounted 

NOVEMBER	 T_03	 Critique Tech. Illustrs. / Overview Photographic Images, WB	 Assignment: Kinds of Photographic Image, WB

	 H_05	 Overview Adobe Photoshop / Tools, Layers, Modes, AdjustmentsAssignment: Tools, Layers, Modes, Adjustments in Pshop 

	 T_10	 Masking, Clipping Paths —Photoshop 			   Assignment: Masking, Clipping Paths

	 H_12	 Making a Toy 			   Assignment: Making a Toy—first attempt, document process 

	 T_17	 Refining Toy, Name Toy, Create Logo / Design Process		  Assignment: Creating a Logo / Design Process 

	 H_19	 ((( Prototype Hang card for Toy )))		   	 Assignment: Design Hang card / Design Process 

	 T_24	 Refine / Develop final Toy, Logo, Hangcard			   Assignment: Near Final Toy, Logo, Hangcard 

	 H_26	 — — no class — Thanksgiving Break — 		   	  

DECEMBER	 T_01	 Critique Toys! / Photograph Toys with Light Kit			   Assignment: Photos of Final Toys for Workbook

	 H_03	 Preflight / Packaging Files —InDesign			   Assignments: Preflight/Package Files  
		  Print Settings, Marks, Bleeds, Export PDF —InDesign				           Print Settings, Marks, Bleed 

	 T_8	 Review Design & Tech Specs / Refine Workook as needed		 Assignment: Refine Workbook

	 H_10	 Develop & refine Workbook	 		  ASSIGNMENT: >>> Send Workbook PDFs to Printing & Design 

	 T_15	 Course Reflection & Evaluations / Present Final Workbooks		   			    

	 H_17	 FINAL EXAM MEETINGS:  Sign Up for Individual Meetings on Thursday, December 17, 9:00am-1:00pm  //   

	 Note: This schedule is subject to change.
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ART 211  GD Production I 

DAILY ASSIGNMENTS

The general text for each of the Assignments are located on the class Basecamp space.  
Note: each assignment is to be completed with your additional text and images with 
captions and uploaded as a PDF by the due date to recieve full credit. Five points will be 
docked for each day the assignment is late.

The content in these assignments will be used to populate your Design Skills Workbook. 

TITLE / CONTENT OF ASSIGNMENT							       DUE (Before Class)

1.	 Print Design, Paper and Printing (20 pts.)	  Upload to Basecamp by 	Tues, Sept. 8

2.	 Print Design Analysis (20 pts.)						      Thurs, Sept. 10

3.	 Thumbnails for layout (10 pts.)						      Thurs, Sept. 10

4.	 INDESIGN Pages, Tools, Guides, Grids, Master Pages (20 pts.) 	 Tues, Sept. 15

5.	 Type I—Typeface Categories, Type Basics (10 pts.)			   Thurs, Sept. 17

6.	 Type II—Leading, Alignment, Indents, Spacing (10 pts.)		  Tues, Sept. 22

7.	 Type III—Paragraph & Character Styles (10 pts.)			   Thurs, Sept. 24

8.	 Type & Image—Text Wrap, Screenshots (10 pts.)			   Tues, Sept. 29

9.	 Color Spaces, Spot Color (10 pts.)					     Thurs, Oct. 1

10.	Creating PDFs (10 pts.)							       Tues, Oct. 6

11.	Illustration Kinds, File Formats (10 pts.)					     Thurs, Oct. 8

12.	Technical Illustration—on paper / Scan image (20 pts.)		  Tues, Oct. 13

13.	ILLUSTRATOR Artboards, Layers, Tools, Image Trace, Pen (20 pts.)	 Tues, Oct. 20

14.	Technical Illustration (Digital Line Drawing)—views (30 pts.)		  Thurs, Oct. 22

15.	Color in Illustrator, Gradient, Gradient Mesh Tool (20 pts.)		  Tues, Oct. 27

16.	Printing, Trim Marks in Illustrator (10 pts.)				    Thurs, Oct. 29

17.	Technical Illustration (Full Color)—all views, digital (50 pts.)		  Tues, Nov. 3

18.	Kinds of Photographic Image, WB (20 pts.)				    Thurs, Nov. 5

19.	PHOTOSHOP Tools, Layers, Modes, Adjustments  (30 pts.)		  Tues, Nov. 10

20.	Making a Toy—first iteration, document process (20 pts.)		  Thurs, Nov. 12

21.	Name Toy, Creating a Logo / Design Process (30 pts.)		  Tues, Nov. 17

22.	Design Hang card  / Design Process (30 pts.)				    Tues, Nov. 24

23.	Toy Final (50 pts.) 								       Tues, Dec. 1

24.	Preflighting, Packaging Files in InDesign (20 pts.)			   Tues, Dec. 8

25.	Print Settings, Marks, Bleeds in InDesign (20 pts.) 			   Tues, Dec. 8
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HOW-TO  UPLOAD DAILY ASSIGNMENTS TO BASECAMP — PG 1
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HOW-TO  UPLOAD DAILY ASSIGNMENTS TO BASECAMP — PG 2
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Print Publication Design Analysis: Key Properties, Grid, Type, Image 

	

KEY PROPERTIES 

PUBLICATION NAME: OnWisconsin 

AUDIENCE: Alumni of UW-Madison 

PAGE SIZE:  8.375" x 10.875" 

NUMBER OF PAGES: 68 (incl. covers) 

BINDING STYLE:  Saddle stitch 

KIND OF PAPER:  Covers are Cover stock, 

coated, matte; Interior pages are Text 

weight, also matte
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Print Publication Design Analysis: Key Properties, Grid, Type, Image 

	

GRID / PAGE LAYOUT 

Above is one of the page spreads for the 
feature story. On the right is an image of 
an analysis of the grid structure. Important 
measurements are listed below.

PAGE MARGINS:  

Top = .9375", Bottom = .75",  

Outside = .6875", Inside = .75"

NUMBER OF COLUMN: 3 

COLUMN WIDTHS:  

Normal running text = 2.875"  

Captions = .8125" 

Inset Info = 3.4375"

GUTTER WIDTHS: .1875" 
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Print Publication Design Analysis: Key Properties, Grid, Type, Image 

	



ART 211 Graphic Design Production I — Fall 2016 — Hoover

ART 211   Design Skills Workbook
GENERAL DESCRIPTION 

The Design Skills Workbook is a record of the topics we 
cover in class and a print publication that you design. 

 

PROJECT GOALS / DESIGN CONSIDERATIONS

This design project is an instructional 
workbook. Clarity in conveying 
information is the main goal. Visual 
interest is a consideration though 
the layout needs to be support 
readability.  

Organization of Content  
Design is about ordering 
information and directing the 
viewer. Thoughtful planning and 
arranging of the content in your 
Workbook is critical. You get to 
decide how the content is divided, 
grouped and organized and how 
the pages layout. You know 2D 
design principles already (balance, 
proximity, scale, etc.), and for this 
project visual hierarchy, consistency 
and variety will play a strong role. 

Incorporating a Grid 
Use of a grid to guide your content 
placement is required. You will see 
how using the grid will enable you to 
implement a consistent layout. 

Balanced Consistent Visual Program  
Developing a visual system to 
achieve hierarchy and categorize 
information is an key learning goal. 
All of the elements you use—text, 
images and graphics—should be 
styled with a coherent whole in 
mind. Enough variety needs to 
be incorporated into the visual 
program to create interest.

Typography 
Typeface choices impact your 
design in a huge way. For this 
project you need to use typefaces 
that are appropriate, legible and 
readable. You must distiguish and 
use text and display typefaces 
correctly. 

Strong type hierarchy is another 
of the goals of this Workbook. 
Establishing a good hierarchy 
will allow the reader to scan 
information efficiently—a central 
concern for every designer. 

Imagery / Graphics / Color 
The images you use must be self-
generated, not pulled from the 
web. They need to  be of good 
quality and to communicate 
clearly. 

Graphics can be helpful to 
organizing content and they can 
add visual intrest. If graphics are 
only decorative they may detract 
from good design. 

Color communicates emotionally 
and, when used well, can aid in the 
scan-ability of content. 

Workbook Binding  
Our Workbooks will be spiral bound. 
You will have the option to choose 
either black or white spiral.

ABOUT THE CONTENT 

STRUCTURE / Workbooks are required to have Title pages, Table of Contents, 
organizational and navigational elements, front and back covers. All of these have 
specs to follow.

TEXT / An outline and some text will be provided to you for each Assignment. You will 
be responsible for adding text to clarify concepts being represented. You will need 
to make sure sections have titles and your images—whether screenshots or diagrams, 
have captions. 

IMAGES / You are required to generate your own images to illustrate each of the 
topics. You can use screen shots of the software program interface, photographs, 
drawings or diagrams. You are NOT allowed to use someone else’s images or pull 
something off the web. All of the images you use to visually explain concepts need 
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ART 211 

design skills workbook TOPICS 
DESIGN FOR PRINT  
�Types of Printed Pieces / Formats 
Types of Paper 
Types of Printing 
Grids in Print publications 

TYPOGRAPHY  
Categories of Typefaces 
Text vs Display Typefaces   
�Measurement of Type, Point size, x-height, 
Set width, Leading, Kerning, Glyphs, Font 
Management, Type Hierarchy 

	� How Styles are used in Text 
Importance of Color Spaces: CMYK vs. RGB 
Kinds of Illustration: Vector vs. Raster,  
    �Continuous Tone, Type as Image,  

Adobe Indesign 
	� Overview of the interface (or workspace) 

Master Pages 
Setting up Guides and Grids 
Auto Page Numbering 
Placing / Using Type 
Threading Text Frames 
Paragraph and Character Styles  
Paragraph Indicators: Space After, Indents 
Tabs 
Hidden Characters 
Placing / Using Images 
Shaping Boxes, Rounded Corners 
Text Wrap 
Basics of Using Color 
Saving Files: Save, Save As, Export as PDF 
Packaging Files 
Print Settings, Marks, Bleeds 

Adobe Illustrator 
	� Overview of the workspace 

Working with Artboards 
Using Layers, Template Layers 

Creating Shapes, Shape Builder and 
Pathfinder 
About Paths and the Pen Tool 
Type Tool, Create Outlines, Type on a Path 
Basic of using Color: Swatches, Process,  
    Spot color, Percentages 
Gradients and Gradient Mesh Tools 
Saving Files: Save, Save As 

Adobe Photoshop 
	� Overview of the workspace 

 

 

 



ART 211  

lesson 1: orientation to labs / digital working

  

About the Mac Environment

+ Login / MyFiles 

+ Navigating / Viewing Options 

+ System Preferences 

+ Your Dock 

+ How to Take Screen Shots

UW-Stevens Point Computer Labs 
+ Locations and Rules in Labs 

+ Available Hardware / Software 

+ Working on Files Locally / Desktop 

+ Saving / Backing Up Files  

+ Printing in the Labs 

+ Lab Assistants  

+ lynda.uwsp.edu

Organizing Class Work /Assignments  
+ Create Class Folder for Assignments 

+ Create Assignment Folders  

+ Class naming convention:  

    LastnameFirstinitial_211_2015_assignmentname 

+ �Use Consistent naming for your files 

Digital Class Space: Basecamp 

+ How to Get There   

+ Organization / Use 

+ Uploads / Folders  		   
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ART 211  

lesson 2: print, paper / physical working

  
Print Design  
There are many kinds of Print Design. General categories include single page items, multiple page 
publications, label and package design.

	 Single page pieces include post cards, posters, tags, flyers. 
	 Multiple page pieces include newsletters, magazines, journals and books. 
	 Label and package design include many levels of branding, identification and information. 

Folding 
Single page design pieces are often folded. Folds range from single to complex.  
Each type of fold is identified by a specific name.  
Folds need to be scored first.  
Problems can occur when folds go across the grain of the paper.

Binding 
Multi-page printed documents are bound in different ways.  
Types of binding include saddle stitched, perfect bound, spiral bound and comb binding.

Package & Label Design 
The range of design options, materials and forms for package design is truly amazing. Materials used in 
packe design are often heavier weight paper board or plastic. Labels utilize specialty lighter weight 
papers or other materials, and can use specific processes to print on non-flat surfaces. 

Paper 
Commercial paper is manufactured according to industry standards. There are a range of 
characteristics and specifications used to identify the different types of paper. These are Grade, Finish, 
Weight, Color, and Grain Direction.

The basic grades (or types) of commercial printing papers are: 
• Bond or writing — usually used for letterheads, business forms and copier uses

• Book — the most commonly used coated and uncoated papers for printing

• Text — high-quality sheets in a variety of surfaces and colors

• Cover — used when greater bulk is required such as book covers, postcards or inserts

• Tag / Bristol / Index — smooth surface papers, mostly uncoated, used for displays, file folders, tickets.

Within each grade there are other distinctions, based on brightness, opacity, fiber content, and finish. 
For instance, there are matte, premium, and gloss finishes to coated papers. 
Text papers are distinguished by finishes like smooth/vellum, felt/embossed, laid, and linen.
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ART 211 

lesson 3: 

Typeface, Type Measurements and 
Designations

Typeface:  The words ‘font’ and ‘typeface’ are often 

used interchangably. A font is a specific typeface at a 

specific weight and specific size. A typeface often has 

several variations (Regular, Bold, Italic, etc.) and can 

have a large ‘family’ like Condensed, Condensed Italic, 

Light, Light Italic, Regular, Italic, Bold, Bold Italic, etc.  

�Type Measurements:  Type size is measured in Points—a 

unit of measure that has been around since the 1600’s 

and standardized in the 1990’s for digital publishing.  

Line spacing (space between lines) is referred to as 

Leading and is also measured in Points.   

Line length or the width of a line or block of text is 

measured in Picas.  

There are 6 Picas to an inch, 12 Points to a Pica, and 

therefore, 72 Points to an inch. 

Designations: Typefaces are designed for different 

purposes. The main distinctions are Display and Text 

typefaces. Display faces are designed specifically for 

use in Titles or Headlines. Text faces are developed to 

be used in running text or body text. 

Type in any publication is also assigned designations 

such as “Headline,” “Subhead,” “BodyText,” 

“Pullquote,” etc.  These designations are used when 

creating Styles.

Adobe InDesign: Getting Text, Using 
Styles in your Document

Getting and Threading Text: The Type Tool is used to 

draw Text Frames (boxes). Text can be typed directly 

into the Text Frame or Placed into the document. Text 

can be Flowed from one column to the next, one text 

frame to another and one page to another. In InDesign 

this process is called Threading the text. 

Creating Styles:  Styles are specific formatting 

charcteristics decided on by the designer. Styles should 

be created for all different designations of text in a 

document. Once a Style is created you can quickly 

apply it to any number of pieces of text throughout 

your document. You can also Redefine the Style once 

and all of the instances it is applied to will change.  

In a typical print document you will build styles for: 

Heads, Subheads, and Bodytext. Often you will create 

many more Styles to handle things like Captions, Page 

Numbers or Folios, Running Headers or Footers, Credits, 

Pullquotes, etc.  

There are two kinds of Styles that you need to be using 

for your type: Paragraph Styles and Character Styles.   

Paragraph Styles: Paragraph Styles are used to style 

paragraphs, text that has leading, spacing before or 

after the paragraph, or other special characteristics. A 

Paragraph is ended when you make a ‘Hard Return’ 

achieved by hitting the Return key. A ‘Soft Return’ is a 

line break within a paragraph, achieved by hitting the 

Shift + Return keys.  

Character Styles: Character Styles are used to style only 

parts of a paragraph like, individual words or phrases.

Font Management

Fonts/Typefaces on the Computer: Typefaces (called 

Fonts on the computer) are stored on the computer 

hard drive. Fonts can be Previewed, Imported and 

Activated via Font management software. The software 

load at UWSP uses FontBook as a management tool. In 

InDesign, Fonts need to be either “Packaged” with the 

print document you are taking to the printer. In Illustrator 

Fonts are generally turned into Outlines, or Vector art, 

eliminating the need for embedding or including the 

actual font.
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ART 211 

lesson 3: type 

• Type Styles & Grids in Design 

	 + Looking at Type and Layout in  magazines

	 + Type Styles in Print Publications 

	 + Grid Structures 

	 + What makes a Grid Flexible?

• Adobe InDesign Styling Text, Using Grids

	 + Selecting Text 

	 + Basic Styles for Text / Paragraph and Character Styles

	 + �Using Master Pages

	 + Multiple Masters

	 + Text Boxes and Columns

	 + Shaping Text Boxes 

	 + Save, Save As and Export

>> study a number of magazines and books 
>> trace 3-4 grid structures for page layout 
>> draw thumbnails for workbook page layout 

Work on your workbook: content

Remember to use the class naming convention:

		  LastnameFirstinitial-211-2013-workbook.indd
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ART 211 

lesson 4: images 

Images in Print Publications 

Visuals or Art:  In most publications you design, you will work with either photographs, illustrations, 

graphics, icons or symbols. Collectively these are referred to as the visuals or the art for the design 

project. All files for visuals used in a print document need to be kept with the files for the print document, 

usually in their own folder. The Image folder—somtimes called a Links folder— is included with a Fonts 

folder when the document is archived and sent to the print house. 

Kinds of Image Types: The two basic types for digital images are raster and vector. Raster images are 

displayed on screen using pixels of varying values and are not easily scaled up to a larger size without 

losing clarity. Vector images, on the other hand, are displayed through mathematical expressions and 

retain total clarity and crisp edges when scaled to almost any size. Photographic images are raster 

images. Illustrations can be either raster or vector images. Most symbols or logos are vector images.

Image File Formats:  Digital images can be created, converted and saved in various file formats. For 

Print you will want to use .tiff, .pdf, .psd or .ai files.   

�Importance of Resolution:  In order to reproduce well when printed your images need to have sufficient 

resolution. For most print processes, photographic images or scans need to be 300 pixels per inch (ppi) 

at the size they will be printed. So, if you are planning visuals for a print piece, make sure the photos 

are taken at the highest pixel resolution. These high-res photos should be kept with the project. You can 

resize a copy of an image and reduce its resolution, but you cannot add resolution to an image that is 

low-res.

Color Formats:  All full-color images used in print documents need to be specified in CMYK color space 

rather than RGB. CMYK—the color space for offset and digital printing—stands for Cyan (C), Magenta 

(M), Yellow (Y), and Black (K). The color space used for onscreen work is RGB or Red, Green, Blue. Your 

images may also use Spot Color or Grayscale. More on Color Space in later lessons.

Adobe InDesign: Working with Images 

Place Image: Images are brought into InDesign by using the ‘Place’ command under File > Place or the 

keyboard combination ‘Command’ + ‘D’.

Links Panel: Images are referred to as ‘Links’ in InDesigh. 

Resizing Images: You can resize images in InDesign by several methods.

Editing Images: Images can be refined or reworked from within InDesign.



ART 211 

lesson 4

 
About Images in Print	 / make sure to cover

Resolution: 			   print vs. screen; ppi and dpi 

Kinds of Images:		  continuous tone images, vector images 

Adobe InDesign

Image Boxes/Frames:		  shapes, text wrap 
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ART 211 

design skills workbook 

FIRST DRAFT 

+ Remember to use the class naming convention:

		  LastnameFirstinitial-211-2013-Workbook-01.indd   (you can use underscores OR hyphens) 

 

+ Package your InDesign file and Compress (Zip file). 

+ �Export your Workbook as PDF/ Print / Smallest File Size. 

+ �Save all of these to your Student folder.  

+ �Upload both your ZIP file and the PDF to the Dropbox / FirstDrafts / on the 
class server.  
Do this before midnight, Friday, September 20.

ART 211 

lessons 5: color

 
Color for Print

Color spaces/systems: 	 Additive vs. Subtractive; CMYK, RGB (more later)

Color in Printing:		  Spot Color; Pantone (basic info, more later)

Applying color to Images:	 full color; grayscale; duotone

Adobe InDesign Content, Color, Package

Image Boxes/Frames:		  changing shapes; rounded corners; stroke

Color Options:			  swatches; gradient

Package Files:			  alerts; archiving; compressing
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ART 211 

lessons 5: color

 
Color for Print

Color spaces/systems: 	 Additive vs. Subtractive; CMYK, RGB (more later)

Color in Printing:		  Spot Color; Pantone (basic info, more later)

Applying color to Images:	 full color; grayscale; duotone

Adobe InDesign Content, Color, Package

Image Boxes/Frames:		  changing shapes; rounded corners; stroke

Color Options:			  swatches; gradient

Package Files:			  alerts; archiving; compressing

  

 

	 a. �Main Uses:  Building digital illustration, creating 

vector graphics, symbols. Illustrator is used to 

create vector artwork and build illustrations. 

	 b. ��New Document:   

File > New Document, or Command + N 

(Contrl + N on the PC) the Artboard, Panels  

	 c. �Tools:  

The panel is located by default on the left 

side of the Workspace. You can change its 

orientation by clicking on the tiny double 

triangles. 

All the Tools have shortcut key commands, 

which are customizable. It is a good idea to 

learn to use both hands when working on the 

computer to utilize key commands and boost 

your efficiency. 

Many Tools have additional Tools hidden 

within. These are designated with a tiny 

triangle on the lower right corner on the Tool 

panel. These Tool Sets can be detached from 

the main Tool Panel. 

COMMONLY USED TOOLS:  

Selection Tools—Selection Tool (Black Arrow), 

Direct Selection Tool (White Arrow) 

Shape Tools—Rectangle, Rounded Rectangle, 

Ellipse, Polygon, Star Tools.  

Transform Tools—Rotate and Reflect 

	 d. �Control Panel: Appears at the top of your work 

space and allows you to make adjustments 

to Frames or to content. The information 

here is contextual—it changes to match the 

particular Tool you are using. 

	 e. �Panels: By default a set of Panels is docked 

on the right side of your Work space. You can 

customize what Panels live in the dock. The 

Pages Panel shows thumbnails of the pages in 

your document and can be used to navigate 

through them.

	 f. �Window: All Illustrator Panels can be found 

under ‘Window’ on the top drop down menu.

	 g.�Save/Save As: As you work Save your files 

regularly. Use Save As to completely replace or 

to create a different version of the file. 

	 h.�Naming Conventions: Use a consistent naming 

convention when Saving your files. When 

naming files for this class use the following 

convention:  LastNameFirstInitial_ART211_2012_

Illustrator_begin.ai 

	 i. �File Formats: Always save as native files and 

other versions as needed.

ART 211 

lesson 6: 

Adobe Illustrator: Overview
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ART 211 

lesson 7 

 
Kinds of Illustration  Divergent Purposes 

Portraiture / Commemorative 

Cartoon / Political Illustration 

Decorative Illustration 

Descriptive Illustration 

Technical Illustration—Product Design, Package Design, prototype visualization;  

Exploded Drawings, Isometric projections 
	

Adobe Illustrator  Overview, Panels, Tools  

OVERVIEW  

�New Document —options 

Saving FIles —options 

Isolation Mode!

TOOL BAR:  
Selection Tools —moving and changing things 

Fill and Stoke —color options 

Other Tools

PANELS:  
Find under ‘Window” 

�Layers 

Swatches, Color 

Pathfinder

ILLUSTRATOR TOOLS 
CUTTING:  
	� Eraser, Scissors, Knife

SHAPES, PAINTING, DRAWING:   
	� Blob Paint Brush – use with the Eraser (not 

precise) 

Shape Builder – additive 

Paint Brush – variable brush size  

Pencil – different effects

PEN TOOL:   
	� Paths and Anchor Points 

Closed Paths  

Control Handles 

Convert Anchor Point Tool    

Join Command 



Adobe Illustrator / Overview
 
File > New Document  
	� Name 

Number of Artboards 
Spacing/Columns 
Width/Height 
Units 
OK

Interface/Workspace

Control Bar 
	 Fill/Stroke Color 
	 Typeface 
	 Point Size

�Tool Bar 
	 Selection Tool 
	 Direct Selection 
	 Type Tool 
	 Rotate Tool 
	 Scale Tool 
 
Dock  
	 Layers

Show Rulers 
Show/Hide Guides 
Show/Hide Grid
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ART 211 

lesson 7 	 —continued

Adobe Illustrator:     

LAYERS  

New, Naming, Locking, Template, Organizing

ILLUSTRATOR TOOLS 
CUTTING:  
�Eraser, Scissors, Knife

SHAPES, PAINTING, DRAWING:   
�Blob Paint Brush – use with the Eraser (not precise) 

Shape Builder – additive 

Paint Brush – variable brush size  

Pencil – different effects

PEN TOOL:   
�Paths and Anchor Points 

Closed Paths  

Control Handles 

Convert Anchor Point Tool    

Join Command 

GRADIENT:  
�Two Main Types of Gradients – Linear and Radial. As the names imply, linear gradients follow a straight 

line and radial applies a gradient following a circular shape.  

Transitions: You can control the transitions from one color into the other—from gradual to abrupt. 

Colors: Each gradient can contain multiple colors that you can set and adjust. 

Transparency: Gradients can transition from a color to transparent or visa-versa.

GRADIENT MESH:  
Apply – There are several methods to apply a gradient mesh to a shape. 

Anchor Points – Each intersection of lines in a gradient mesh is an anchor point that has not two, but four 

control handles. 

Mesh Lines – You can add vertical or horizontal lines to the mesh.   

Mesh Points – You can add individual points along a mesh line to add to the mesh.

 

NOTE: �Always save your documents as native files and version your files rather keep saving over the 

same file. Save your documents in other file formats as needed.
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ART 211 

lesson 8 

Technical Illustration 
Why Technical Illustrations are used

What are Isometric Views? 

Show Examples of the different views 

This should be a scan of your own drawing.  

A simple L-shaped block form works well.

	

Perspective Drawing

Two-point Perspective 

Use a scan of your own drawing

Light Source, Shading and Highlights

Use a scan of your own drawing

What is an Exploded Drawing? 
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ART 211 

lesson 8: 

Illustrating objects:  Using Grids, Isometric Projection, Perspectives   

GRIDS – Used in many types of technical illustrstion, grids come in various sizes and increments as well 

as angles. The planes represented in a 2-Dimensional grid are defined by the ‘x’ and the ‘y’ axes. A 

3-Dimensional grid also has the ‘z’ axis.

PERSPECTIVE DRAWING – There are multiple methods of rendering objects as volumes in space The most 

common is 2-point perspective. Point here refers to a vanishing point on the horizon where lines appear 

to converge. In 2-point perspective there are two points on the represented ‘horizon’ where the lines of 

the drawn ojects or buildings converge.

ISOMETRIC PROJECTION – This is a specific type of 3D representation most often used in illustrating 

exploded views in technical manuals. The angles used in this type of drawing are all regular and lines 

are all drawn parallel not allowing for and perspective rendering. 

Adobe Illustrator:  Grids and 3D effects - part 1  

GUIDES & GRIDS:  
Smart Guides – Guides allow for more precise alignment. In Illustrator (and other Adobe programs)

Smart Guides visually alert you to aligning elements. 

Basic Grid – Your Grid can be turned on and off as well as adjusted under Preferences.  

Polar Grid – Polar Grid allows for creating circular elements divided into equal sections—either consetric 

circles (target or bullseye) or pie slices. 

Perspective Grid – A useful tool for building three dimensional shapes controlled by the Perspective Grid 

Tool—which has its own selection Tool. You can select and draw on the Left, Right and Top or Bottom 

planes which ar color-coded Blue, Orange and Green. There are multiple adjustments that can be 

made to the horizon line or viewing angle as well as the length and height of the planes.

LIGHT AND SHADOW:  
Gradients – Linear gradients can be applied to create shading and the illusion of volume.  

Drop Shadow – Can be applied to visually anchor an object in 3D space. Adjustments to the direction 

on the x or y axis, amount of Blur as well as the Opacity can indicate hard or soft light. 

NOTE: �Always save your documents as native files and version your files rather keep saving over the 

same file. Save your documents in other file formats as needed.
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ART 211 

lesson 9 

Adobe InDesign: Typesetting

Using Tabs, Hidden Characters

TABS AND ALIGNMENT 

There is no way to align text properly or neatly in columns by just using spaces. Whenever 

you need to align text, such as in a Table of Contents or when arranging columns of 

information, tabular data or categories, you absolutely need to use Tabs. Different 

applications will call for different kinds of alignments. Your Tabs can be set as Left, Right or 

Center Justified and can even be set to align on a decimal point or special character.

Command + Shift + ‘T’ to get Tabs.	

HIDDEN CHARACTERS 

When you are setting type you need to know the difference between spaces, hard returns 

and soft returns. In order to see which is being used you can make visible what InDesign 

calls ‘Hidden Characters.’ 

Option + Command + ‘I’ to show Hidden Characters. 

Note: These are not visible when you are in Preview Mode.
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ART 211 

lesson 9: 

 
What Makes Good Design?  Looking at Publications 
 

�PROJECT NEEDS  

Good publication design, like all kinds of graphic design, depends on the needs of the project. The 

goals will be defined by the client and shaped by the target audience.  

The Design skills workbook you are creating for this class needs to clearly communicate the content 

and posess some design characteristics that make it cohesive. It is a workbook that is intended to show 

off your knowledge base. Your inclinations toward fanciful type or decorative shapes will need to be 

curbed if the content is to be rendered in a comprehensible way.

CONSISTENCY  

GRID: An underlying grid structure provides a framework to build consistency for the pages and even 

cover of any publication.  

TYPE: Choosing and using a small number of typefaces throughout a publication can build a sense of 

wholeness. Applying the typefaces in a consistent way is helpful.  

IMAGERY: A consistent quality of images will help establish good flow and visual unity. Sometimes within 

a publication images are treated differently to create  visual puctuation. 

VISUAL PROGRAM: Visual treatments of elements of type, image and graphics need to be considered 

throughout a publication. Variety within a cohesive visual program is valuable to aid in distiguishing 

different sections or areas. 

Adobe Illustrator:  Image Tracing  

TRACING:  
Template Layers – You can place an image on a Layer and designate it as a Template Layer. This 

automatically locks the Layer and grays out the visibility to 50%. This is often the BEST method to work on 

building vector graphics from a rasterized image. 

Live Trace – You can use Live Trace to find the edges of an image and translate it into vector art. This 

method works fairly well when you control the Tracing Options, though, depending on your project 

needs, will often result in more work than using a Template Layer. 

NOTE: �Always save your documents as native files and version your files rather keep saving over the 

same file. Save your documents in other file formats as needed.
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ART 211 

lesson 11:  Preparing for Print, Marks, Bleeds, Package

Preparing for Print:  Digital Print Jobs   

PAGE COUNT MATTERS  
�When figuring the number of Pages for a multi-page document you must consider what is needed 

for the final outcome. A spiral bound or comb-bound publication can have any number of pages. 

A booklet that has folded pages and is saddle-stitched or bound by hand, must have a page count 

divisible by four (4).

PRINTER’S SPREADS VS. READER’S SPREADS  

We set up our multi-page documents in InDesign with Facing Pages to simulate how a reader will see 

the page spreads. When setting up a document

LINKS (IMAGES)  
CONVERT RGB IMAGES TO CMYK (or Grayscale) 

�Since the printing process uses CMYK all of the full-color images (InDesign calls them Links) used in the 

document need to be in the CMYK format. Any images that are to be printed in black and white need 

to be converted to grayscale. These tasks can be accomplished by Opening the images in Photoshop, 

going to the top menu bar and choosing Image > Mode > CMYK or Grayscale as required. 

CHECK FOR APPROPRIATE RESOLUTION 

All continuous tone images need to have a resolution of 300 ppi. If scaling up or enlarging the images 

they will need to have a higher resolution or they can become soft, blurry or pixelly. On the other hand, 

excessive resolution will simply slow down the performance of the digital file. Graphics, or logos should 

have a higher resolution than continuous tone images because the lines of their edges need to be very 

crisp and clean. 

FONTS (TYPEFACES)  
�Every font you use in a document will need to be Licensed in order to be used commercially. Even 

free fonts can have limitations for use built into the Terms and Agreement. Before sending a job to 

print check to make sure you have used only the fonts intended. Sometimes extra spaces can carry a 

different font. Check that all of the fonts in the document are available by choosing Type > Find Font. 

�SWATCHES (COLORS)  
�When preparing your document for printing or archiving you can reduce the amount of Swatches to 

those used in the document. In the Swatches Panel, go to the drop down menu on the upper right 

hand corner and choose Select All Unused. and Delete these. 

SETTING UP BLEEDS  
�If your content bleeds off any of the edges of your paper you will need to set up Bleeds in your 

document. You can do this when setting up the new document or through File > Document Setup. The 

standard Bleed measurement is an eighth of an inch or .125 in.

SHOWING MARKS & BLEEDS  

When preparing your document to send to the printer, make sure you turn on the Crop Marks and 

Bleed Marks if you are using bleeds. When saving a document as a .pdf for viewing online the Crop 
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and Bleed marks are not shown. 

PACKAGING YOUR FILES  

To enable the printer to access the fonts and images you used in your document, you can ‘Package’ 

them all together in a single Folder. You can have InDesign do this for you by choosing File > Package. 

This is also how you check to make certain that all of your images are in good order (in CMYK and high 

enough resolution) and checks the fonts you are using are present and available.  

 
Grids in Design: Print Publications 

	 NOTE: �Work Locally / Save Remotely. Open and work with your documents Locally, that is on your 

Desktop, and Copy the files to your MyFiles, your remote server space.

ART 211 

lesson 11: —Continued
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Page Layout: Measurements & Alignment in Print Publications

�UNITS OF MEASURE: Page sizes vary, though there are some standard sizes used within the industry. In 

the U.S. page sizes are measured in inches. In Europe and elsewhere the metric system is followed so 

page sizes are in millimeters. What are some common page sizes? 

   

Other units of measure used in print work include picas and points.  

1 inch = 6 picas, 1 pica = 12 points, so, 1 inch = 72 points.  

�MARGIN, COLUMN & GUTTER WIDTHS  

Page margins, columns and gutters in print publications are generally measured in picas. Some 

common measurements for page margins are ____________________. Column and gutter widths depend 

on the kind of grid structure used and the page size.  

�PARAGRAPH INDICATIONS 
The two most common methods to indicate new paragraphs are: 

1. Indents and  

2. Space between paragraphs.  

You only need to use one of the methods, not both. A beginning paragraph will somtimes have an 

initial cap, but it should not have any indent or space before. 

�ALIGNMENT & JUSTIFICATION  

There are multiple ways to align your text including justifying it to the left, to the right, centering or 

having a random alignment. In English language print design, most text is set either ___________  

or ____________ justified.

ART 211 

lesson 13: Export Files as .pdf / Intro Acrobat
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MORE PARAGRAPH STYLES: Set your Paragraph styles first. Use names that clearly describe 

the category of text. Set the Basic Character Formats, Font Family and Style, Point Size, 

Leading. Also consider the Indents and Spacing as well as Hyphenation.

MORE CHARACTER STYLES: Set your Character styles after establishing your Paragraph 

Styles. Remember to use names that identify the category of text being Styled. 

Typography 

Measurements for Type:  	 Points and picas; point size/leading; height, width, weight   

Categories of Typefaces:	 Serif, Sans Serif, Script, Monospaced; Diplay faces vs.Text faces

Typeface vs. Font:		  Typeface families   

Adobe InDesign

Page Furniture 

Page Numbers 
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Visual Program: Components

GRID: A good grid structure will provide the basis for visual consistency throughout a publication. 

Flexible grids that have multiple columns and rows can easily accommodate variation in page 

layout while maintaining the overall visual program.  

TYPOGRAPHIC ELEMENTS:  Every publication adopts a visual style that pertains to its typography. 

Often there is a mix of styles integreted into various parts of the page adding to the whole. 

Typeface choices, leading, alignment and paragraph indicators are a few of the typographic 

elements used to shape a particular identity. Others include Drop Caps, lead-in text, callouts or 

pull quotes. 

�GRAPHIC ELEMENTS:  Publications often incorporate graphic elements that are used to denote 

specific content areas or to announce a section change. Some common graphic elements 

include linear marks or lines of various weights referred to as Rules; fore-edge bars (thick lines 

on the outer edge of the pages); and graphic elements incorporated into running footers or 

headers.

�GRAPHIC STYLES:  Publications employ graphic styles to appeal to a specific audience. 

InDesign: Defining Components

PARAGRAPH RULES: To apply a line (rule) above or below some element, define the line format 

and offset in Paragraph Styles.  

��DROP OR INITIAL CAPS:  Use a Paragraph Style to define the number of lines of text a Drop Cap 

spans.

��TYPOGRAPHIC ELEMENTS:  A Pull quote or Call out —text that summarizes a point made in the 

text— adds visual interest to a page layout.

ART 211 

workbook lesson 14: Consistent Visual Program & Hierarchy
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exercise for lesson 14: 

PART 1 Work in a group of 2 or 3 for this part. One member of 
each group should create a Word document and record the 
names of people in the group as well as the answers you come 
up with.

Identify the elements used to shape a particular 

visual program. Study the visual styles in the 

publications below and analyze how each 

communicates. List the specific elements that 

contribute to the publication’s voice. Make notes 

on the following: 

1. Page layout—such as amount of open space, 

amount of variety in page layout  

2. �Typographic elements including typefaces and 

styles used, alignment/justification, use of initial 

caps, lead-in text, pull quotes, running headers or 

footers, folios

3. Graphic Elements—such as use of rules, bars or 

boxes 

4. Image treatment

	 �Find-Plants-Natural 
http://www.amazon.com/Harvesting-Color-Find-Plants-
Natural/dp/1579654258/ref=sr_1_13?s=books&ie=UTF8&qid=1
350878921&sr=1-13&keywords=harvesting

	 �Grow-Your-Vegetables  
http://www.amazon.com/Everything-Grow-Your-
Vegetables-Book/dp/1440500134/ref=sr_1_29?s=books&ie=U
TF8&qid=1350879361&sr=1-29&keywords=harvesting

	 �Mushroom Hunter 
http://www.amazon.com/Complete-Mushroom-Hunter-
Illustrated-Harvesting/dp/1592536158/ref=sr_1_44?s=books&i
e=UTF8&qid=1350879636&sr=1-44&keywords=harvesting 

	� Universal Principles of Design  
http://www.amazon.com/Universal-Principles-Design-
Revised-Updated/dp/1592535879/ref=sr_1_4?s=books&ie=UT
F8&qid=1350911244&sr=1-4&keywords=design

PART 2  Work individually for this part. When you are done, 
Save your InDesign file using this convention: LastnameFirstInitial_
TypeHierarchy.indd  and upload it to the Class Server Dropbox.

Create a New 1-Page, Letter-sized Document in 

InDesign. Using the text provided and only one 

typeface, create a single page layout that uses 

strong type hierarchy to help in creating visual 

interest and reading the content. Develop and 

apply the following Paragraph / Character Styles 

for your layout. 

1. Bodytext

2. Article Title

3. Byline (by Author Name) 

4. First Paragraph (with Initial Cap)

5. Side bar Title and Text

6. Jumpline

7. About the Author (with Rule Above or Below the 
title)
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• Point Sizes of Type

	 a. �BODYTEXT:  A good, comfortable point size for running text is 8–10 points.  

	 b. ��HEADLINES:  The point size for Headlines or Page heads can vary greatly. Generally 

speaking, the point size is determined by the style/approach taken in the design of the 

publication or print piece. 

	 c. ��CAPTIONS & CREDITS:  The point size for captions is usually smaller than the bodytext. For 

credits, like photo credits, the point size often is 5–6 points.

• Measure of Type

	 a. ��COLUMN WIDTH (A.K.A. MEASURE):  The width of a column of type is also called the 

‘measure’ of the type. The length of lines of type makes a big impact on how easy the type 

is to read. Optimal line lengths for type measure are commonly between 50-70 characters. 

		  �If the lines are too long :: the reader’s eye will have a hard time focusing on the text.  

An excessive length makes it difficult to see where the line starts and ends. It often 

causes difficulty continuing to the next correct line in a block of text.

		�  If the lines are too short :: the reader’s eye will be forced to travel back and forth 

too often, breaking the reader’s concentration. This tends to create stress in people, 

making them begin on the wrong line, potentially missing important words or the main 

point of the text.   

ART 211 

lesson 15: Size Matters —Part One
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ART 211 

lesson 16: Introduction to Photoshop

Adobe Photoshop: Overview 

Main Uses:  Manipulation and adjustment of digital photographs and building composite photographic 

imagery such as digital collages. 

New Document:  To create a new document, go to the top horizontal menu and choose File > New 

Document, or simply use the key command, Command + N (Contrl + N on the PC). You are able to 

choose from Preset sizes or enter your own dimensions for the document. Choose your Color Mode 

(CMYK or RGB), your resolution and the Background Contents for your document (White, Background 

Color or Transparent).  

Panels and Tools: Similar to Illustrator, there are Panels to control various tasks that can be docked 

together or pulled apart. Located by default on the left side of your Workspace, the Tools panel has 

several categories of tools including the Selection Tools, the Painting/Manipulation Tools and the 

Drawing/Typing Tools. Many of the Tools have customizable shortcut key commands. It is a good idea 

to learn to use both hands when working on the computer to utilize key commands and boost your 

efficiency. 

A number of Tools have Tool sets embedded in them that can be detached from the main Tool Panel. 

These Tools have a tiny triangle on the lower right corner on their icon.  

�Control Panel: As in InDesign and Illustrator, the Control Panel or bar appears at the top of your 

workspace. The information here is contextual—it changes to match the particular Tool you are using. 

Panels: You can control how many and which Panels are visible, open and docked on the right side of 

your Workspace. 

Window: All Photoshop Panels can be found under ‘Window’ on the top drop down menu.

Save/Save As: As you work Save your files regularly. Use Save As to completely replace or to create a 

different version of the file. 

File Formats: There are many different file formats to choose from when saving your work in Photoshop. 

The file format you choose will depend on what purpose the image is intended...for screen/web or for 

print. The most common File formats for Print include: .tiff, .eps. and .pdf. For screen common formats 

include: .jpg, .png, and .gif.  Get in the habit of saving your work in Photoshop as native Photoshop files 

so you can go back into them and rework. Native Photoshop files are Saved in Layers and have .psd as 

their suffix.  

Naming Conventions: Use a consistent naming convention when Saving your files. When naming files for 

this class use the following convention:  LastNameFirstinitial_ART211_2012_Photoshop_01.psd

 � 
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• Vector vs. Raster (Review)

	 a. �VECTOR IMAGES:  These images are completely scalable and are therefore an ideal format for logos 

and symbols. Vector images are defined by __________________________. When saving vector images 

for printing they are generally saved at a high resolution (1200ppi).  

	 b. ��RASTER IMAGES:  An image that has smooth, continuous tones is rasterized when made digital. A 

raster is another name for a grid or a matrix. When saving raster images for printing they are always 

saved at the resolution needed for the kind of printing (generally 300ppi at reproduction size).

• Image Resolution

	 a. ��GENERAL:  Resolution is a term used to refer to the amount of detail or visual information in an 

image. It is used when refering to a digital image as well as images when printed. Images meant for 

display on a screen need much lower resolution than images created for print. As a comparison, 

your computer monitor has a resolution of 72 or 96 ppi. Most printed magazines use images with 

resolution of 300 ppi at the printed size. 

	 b. ��PPI, DPI, LPI:   
PPI stands for Pixels Per Inch and refers to the number of pixels (derived from the phrase ‘picture 

element’) per square inch. Whether working with images in a digital camera, scanner  or in pixel-

based software programs, PPI is used to define the amount of information, detail and quality of 

the digital image. DPI stands for Dots Per Inch and refers to the resolution of output devices such 

as desktop printers. Laser printers use dots or toner and inkjet printers use dots CMYK ink. LPI stands 

for Lines Per Inch and refers to the coarsness or fineness of screen a commercial printer uses to print 

images. 

	 c. ��RESOLUTION & KINDS OF PRINTING:  Different kinds of printing use different resolutions in their screens 

(LPI).   

Some examples:  Newspapers are mostly printed using fast web presses on coarse paper that 

absorbs a lot of ink. In order to avoid the images getting all muddy from ink spreading, they use a 

lower LPI in their printing. Low LPI means fewer lines per inch to define an image.   

Fashion magazines use high-quality offset or gravure printing processes and less absorbent paper. 

They use high LPI so the images are super crisp and clear. The dots of ink are small and sit on the 

surface of the paper rather than being absorbed and spreading out. In order to take advantage of 

this, images must be saved at a high ppi. High PPI means lots of pixels per inch to define details.   

 

ART 211 

lesson 17: Vector/Raster, Image Resolution (Size Matters —Part Two) 
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Find the Best LPI, By Jacci Howard Bear, About.com Guide, 
http://desktoppub.about.com/od/resolution/a/lpichart.htm, October 
2012
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ART 211 

lesson 18: Color space / Photo Lighting / White Balance (WB)

 
Color Modes / Spaces: Systems of Representing & Perceiving Color 

Additive Color:  This color space (mode) is at work when light is emitted from a device. It begins from 

Black (no light—think dark computer screen) and as color is added represents the color spectrum. 

Additive color uses primaries of Red, Green, and Blue (RGB) that resonate with the different structures 

(cones) in our eyes.  

When the Red, Green and Blue wavelengths of light are added together they create white light. 

The individual pixels of RGB do not actually overlap, but are mixed in our retinas. When we look at a 

screen on a device—whether it is on a phone, tablet, computer or an ATM interface—we are seeing 

color in an Additive color space.   

RGB colors are expressed as the amount of Red, Green and Blue measured on a scale between 0 

and 255 or as a percentage.

��Subtractive Color:  This color space (mode) is at work when we are looking at physical dyed, painted 

or printed paper or objects. The colors we see are a result of light being reflected off of the objects 

or paper. It begins from white (think blank paper) and as color is applied it subtracts from the full 

spectrum of white light. The primaries in subtractive color are Cyan, Magenta, and Yellow (CMY). You 

already know that in color printing technology, ‘K’ or a Key plate is used to define the Blacks, yielding 

the CMYK printing color space.   

RGB > HSI, HSL, HSV: There are variations in modeling the Additive or RGB color space.The RGB color 

space is usually represented as a cube where the red green and blue channels are mapped onto the 

X, Y and Z axes. HSI or Hue, Saturation and Intensity; HSL or Hue Saturation and Lightness; and HSV or 

Hue Saturation and Value are modeled as cylindrical forms. 

Photo Lighting / White Balance   

White Balance: “White balance (WB) is the process of removing unrealistic color casts, so that objects 

which appear white in person are rendered white in your photo. Proper camera white balance has 

to take into account the “color temperature” of a light source, which refers to the relative warmth or 

coolness of white light. Our eyes are very good at judging what is white under different light sources, 

but digital cameras often have great difficulty with auto white balance (AWB) — and can create 

unsightly blue, orange, or even green color casts.” 	 From Cambridge in Colour— http://www.cambridgeincolour.

com/tutorials/white-balance.htm
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lesson 19: Adjustments, Levels, Color Balance  / Photoshop 

Adobe Photoshop: Actions! 

Process Images with Actions: In Photoshop you can set up a specific series of steps as an Action. The steps 

can make adjustments, resize, convert, save and close your images. This Action can then easily be applied 

to other images.

Convert Color images to Grayscale: In Photoshop you can convert your RGB Color images to Grayscale 

using Actions.  

	 >  �EXERCISES: 1. Make your own Action for the Lesson 19 images. Convert to Grayscale, Resize, Save 

and Close. 2. Work with each of the Lesson 19 images to correct the Color Balance. Copy all of the 

images into in a New Folder beginning with LastnameFirstinitial and upload to the class server. 

Adobe Photoshop: Making Adjustments to Digital Photos 

�Adjustment Layers: You can make adjustments to your images in Photoshop non-destructively, by using 

Adjustment Layers. These are most helpful to preserve the original image and to work on several kinds of 

Adjustments together.

Histogram: A Histogram is a graph that visually represents the tonal range of a digital image. In Photoshop 

the histogram shows both Input Levels and Output Levels, where Input makes adjustments to the digital 

image on screen and Output is making sure the levels are appropriate for Print.  

Blackpoint and Whitepoint values need to be manipulated in the Output so the dark areas don’’t fillin or 

plug up detail and so that the light areas are notblown out.  

Adobe essentials has additional info: .photoshopessentials.com/photo-editing/histogram/

Levels:  In RGB space there are 256 levels of dark to light. Digital photographs have a range of values 

or tones (darks–middles–lights) that can sometimes get ‘muddy’ in the middletones. When this happens 

some of rich details are lost. In Photoshop you can retrieve the detail in the midtones by using ‘Levels’ and 

making adjustments to the image.  

Color Balance:  The best way to get a good Color Balance is to use the correct White Balance (WB) when 

taking your photos. If the WB is off your Color digital images will have a color cast.  

With the color balance of a digital image your eye CAN be a good tool, though your eye CAN be fooled. 

Color calibration of your computer monitor and or any printer affects color balance. Sometimes this is 

beyond your control.  

You can work to eliminate a color cast using the Color Balance or the Levels Adjustments in Photoshop. 

In order to fix the image color you will need to have a neutral grey or a grey color that has equal parts of 

Red, Greeen and Blue (RGB). The use of a gray card in your photo will give you a source for a true middle 

grey which balances the levels of Red, Green and Blue in the image.
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lesson 20: Isolating Pixels in an Image 
(Separating Object from Background) / Photoshop—part I

Adobe Photoshop: Selections, Masks and Alpha Channels 

Selections: The act of choosing some of the pixels in a digital image in order to manipulate 

that area. A selection is defined by “Marching Ants.” There are many ways to make selections in 

Photoshop AND there are many ways to refine the edges of your selections. 

> Select All (Cmd + A)  / Deselect (Cmd + D) / Reselect (Shift + Cmd + D) 

> Marquee Tools: Rectangular, Elliptical —both can be constrained to perfect square or circle by using 

the Shift Key while drawing the Marquee. 

> Lasso Tools: Freehand, Polygonal, Magnetic  

> Magic (Tragic) Wand: Tolerance, Anti-Aliased, Contiguous  

> Quick Selection Tool: Less Clicking

	      �• All Selections once made can be moved or refined. Find these commands under the top 

drop down menu Select > Modify: Smooth, Expand, Contract, Feather. 

• You can Add to an existing live selection by holding down the Shift Key and selecting more. 

• Once a Selection is made you can create an Adjustment Layer to manipulate the pixels 

selected. The selection is automatically turned into a Mask. 

• Adjustment Layers are editable. You can add to or subtract from the selected areas by 

“painting” with your Paintbrush tool (White=Add to mask; Black=Subtract from mask) 

Masking: Any Selection of pixels can become a Mask. A selection defined by the “Marching Ants” 

can be also viewed using the Quick Mask mode. (Press the ‘Q’ Key)  

In Masks, “white reveals and black conceals.” So if you want to increase your masked area, paint with 

black.  

• Any Selection  or Mask can be stored as an Alpha Channel. 

Alpha Channels: Alpha refers to Transparency. Creating an Alpha Channel is a way to save 

a selection of isolated pixels within the Photoshop (.psd) file. The Channels Panel is where the 

information for Alpha are shown.  
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ART 211 

workbook lesson 20: Isolating Pixels in an Image 
(Separating Object from Background) / Photoshop — part 2

Adobe Photoshop:  

Edges of Selections and Masks 

• Selections can be refined or modified by contracting or expanding the selection.  

• They can also be adjusted by smoothing the edges, to diminish the appearance of 

“jaggies” or pixelation on the edges. 

• You can create vignettes by softening your selection using Feathering.

Clipping Paths 

• Selections can turned into Clipping Paths. This is a method to isolate pixels of a figure or 

area in an image. Using Clipping Paths, an object can be sparated from its background. 

Composite Images 

• Objects or figures on transparent background layers can be recombined with other 

images to create composite images. 
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workbook lesson 21: About Paper 

General Information 

MOST COMMON PAPER GRADES
Cover: a heavyweight paper used for cards and covers of many kinds; scoring needed for folding 

Text: a lighter weight paper for letterhead, envelopes, interior publication pages; folds without scoring 

Writing or Bond: sturdy, lightweight multi purpose paper

�SOME PAPER TERMS

Basic Size: standard dimensions a 
type of paper is cut to (Bond is cut to 
17”x 22”; Offset to 25”x 38”) 

Basis Weight: the designated fixed 
weight of 500 sheets, in pounds, of 
that paper’s basic sheet size. 

Brightness: refers to the reflectiveness 
of white paperstock

Bristol: a board grade receptive to 
folding, embossing, and stamping

Caliper: the measure of the thickness 
of paper in microns

Coated: book paper with a clay 
coating ensuring smoothness (dull, 
satin, gloss, matte)

Digital: paper for copiers, ink-jet and 
laser printers, also high-end digital 
presses

FSC: Forest Stewardship Council—
an organization overseeing 
management practices of forests

Grain: direction fibers run in the 
paper; folding across the grain breaks 
fibers, causes cracking

GSM: a measurement for paper 
weight (Grams / Square Meter)

Linen: true linen paper is made from 
flax fibers; term applied to high quality 
paper with finish like linen

Newsprint: coarse paper used for 
printing newspapers; highly acidic, 
degrades quickly

Offset: a book paper treated with 
sizing to resist moisture used in offset 

printing

Opaque: a book paper treated to be 
less transparent

PCF: Processed Chlorine Free—better 
environmentally speaking

�Show through: refers to seeing through 
the paper to the printing on the flip 
side

Smoothness: refers to the presence or 
absence of tooth or texture 

Vellum: true vellum is made from 
calfskin; ‘paper vellum’ is made 
from cotton, is transluscent and 
dimensionally stable; vellum is a term 
applied to some writing papers to 
denote extra smoothness

SOME PAPER COMPANIES

Appleton is an employee owned 

paper mill located in the Paper 

Valley region of Wisconsin. As a 

specialty coating facility Appleton 

makes a variety of paper for graphics 

applications and industrial use.

Domtar Paper has the broadest line of 

eco-friendly and FSC certified paper 

and envelopes.

French Paper Company has been 

manufacturing paper for more than 

140 years in the same community of 

Niles, Michigan; iconic paper brands 

like Speckletone, Dur-O-Tone, Pop-

Tone, and Construction have made a 

big impact on the design community; 

FSC certified. 

Mohawk Paper the largest privately 

owned premium text and cover 

paper manufacturer; uses wind power 

and produces many eco-friendly 

papers. 

Neenah Paper offering the “Classic” 

line of uncoated text and cover 

papers and envelopes, eco-friendly 

papers with FSC certification and 

papers made using wind power.

Wausau Paper a leading 

manufacturer of text and cover 

paper with matching envelopes 

for many years. It’s flagship brand 

Astrobrights is the best known brand 

of bright colo   red paper in the 

market.

�Unisource is a distributor for all major 

paper companies, like a paper super 

store.  

PAPER SAMPLES 
Swatchbooks help designers see 

and feel the characteristcis of paper 

available

Paper Promotions are designed to 

promote a new or existing line of 

paper to the market

Ordering Samples designers and 
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lesson 22: Pantone Colors +  

About Pantone Matching System 

OVERVIEW 
The Pantone Matching System (PMS) was developed in 
the 1960’s as a standardized method for matching colors 
in commercial printing operations. It has been widely 
adopted throughout the printing and design industries. 

	     �This system uses formulas of base pigments that 
make Solid Pantone colors (a.k.a. Spot colors). 
Pantone produces various printed color guides, 
built as fan books, and pages of perforated 
color chips to assure consistency in color use 
from designer to client to printer. The color guides 
represent specific colors on both coated and 
uncoated paper.   

PANTONE GUIDES
Formula Guide: This guide presents the Pantone colors 
(Spot colors) that are mixed from a set of base pigments. 
Guides are printed on Coated, Matte and Uncoated 
papers. There are over 1,000 different Pantone colors.

4-Color Process: Some, but not all, Spot colors can be 
translated well through the 4-color process. Specific 
guides represent the set of Pantone colors that can be 
accurately produced using CMYK or Process colors.

Color Bridge: This guide represents solid Pantone colors 
and their closest, CMYK, RGB and HTML (like Hexidecimal) 
equivalents. 

Specialty Colors: These are guides that represent an 
array of metallic, pastel and neon colors as  
Pantone solid colors.

		� 

Color Sharing Communities

ADOBE KULER 
An online community where people create and share 
their own color pallets. Wikipedia states that ‘Kuler’ is the 
word for ‘color’ in the Creole language spoken on the 
island nation of Mauritius.

COLOUR LOVERS 

“COLOURlovers is an international [internet]  
creative community that helps people discover  
their inner designer.”

Digital Color Pallets, Swatches   
   (information from adobe.com) 

�ADOBE DESIGN SOFTWARE 
Pantone colors guides can be loaded in Adobe InDesign, 
Illustrator and Photoshop. In CS6 the libraries are called 
Pantone +. Adobe Kuler is also available as an Extension 
to the Creative Suite programs (see below). As always, 
be aware of the inherent difference between color 
viewed on a computer monitor and color printed onto 
paper.

INDESIGN 
The Swatches panel (Window > Color > Swatches) allows 
you to create and name colors as well as open color 
libraries. When you choose Create New Swatch, you 
can choose Process or Spot color. If you choose Spot, 
you then can select from various color libraries including 
Pantone guides. You can save your Swatches in an 
Adobe Swatch Exchange (.ase) file which can be shared 
and imported to other files. Swatches panel uses little 
icons to identify Spot and Process color types, LAB, RGB, 
CMYK, and Mixed Ink color modes. 

ILLUSTRATOR 
Adobe Illustrator has three types of color swatches—
process, global, and spot. Process and global color 
swatches are related to the document color mode. If 
you change the document color mode from CMYK to 
RGB, the process or global colors are converted. Unlike 
process and global color swatches, Spot color swatches 
preserve the definition and color modes (CMYK, RGB, 
LAB, Grayscale, HSB, or even WebSafe RGB) they are 
created in. Spot color swatches are either created by 
people using the program or specified from color libraries 
(books) created by companies like Pantone.

PHOTOSHOP 
Adobe Photoshop behaves very much the same as 
Illustrator when it come to color swatches and accessing 
color books. 
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lesson 23: Page Numbering  | InDesign 

	 a. �PAGE NUMBERS IN PRINT PUBLICATIONS

		�  Generally speaking page numbers do not begin at ‘1’ and they never should start on the first page of a 
publication. Page numbers are not appied to ALL pages. Often the TOC does not get a page number. 

	 b. �AUTO PAGE NUMBERING

		�  On your Master Pages create a text box on the verso page to hold your folios or page numbers.  
With your cursor inside, go to Type > Insert Special Character > Current Page Number. Choose the typeface and 
style. Duplicate and adjust the text box for the recto page in the spread. 

	 c. �NUMBERING

		�  On your Pages Panel: make sure you have selected the page thumbnail you want to effect, then choose the fly-
out menu on the top right corner > Page Numbering Sectioning options and enter the number you want to start 
with. 

	

lesson 24: Binding and Post-press processes 

	 a. �SOME TYPES OF BINDING FOR PUBLICATIONS

		�  Perfect Bound: a method used by many magazines, this forms a spine 

Saddle Stitched: a method used by a majority of booklets, pamphlets, some magazines and other smaller 

publications 

the print documents need to have a number of pages divisible by four (4). 

Spiral / Wire Bound: an option that allows for page spreads to lay flat, good for direction-based pieces like 
manuals 

	 b. �SOME POST-PRESS PROCESSES

		�  Scoring and Folding: scoring is putting a crease in the paper before folding, and folding allows for reducing 
the size of the paper document for binding options or for mailing.

		  Spot Varnish: a process where varnish is applied to selected areas on the paper

		  Foiling: an application of shiny foil material to specified areas on the paper. 

		  Die-cutting: a process that cuts paper stock into specific shapes.
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PROJECT 1 | TECHNICAL ILLUSTRATION			   page 1

As a designer you are required to produce different kinds of sketches, drawings and 
renderings for clients and collaborators. In order to evaluate the overall look and feel of 
a product long before it is physically built, designers visualize them with illustrations from 
different angles. 

The goals of this project are two-fold:  
1) to deepen your drawing skills by 
completing hand-drawn illustrations and 
orthographic projections, and 

2) to familiarize you with Adobe Illustrator as 
a tool for rendering technical illustration.

ORTHOGRAPHIC PROJECTIONS 
Also known as engineering drawings or sometimes 
plan views, orthographic projections represent 
a dimensional object from different angles or 
views. Conventionally these drawings include a 
top view (also called a plan view), a side view, a 
front and/or rear view along with a three-quarter 
angle view, either isometric or perspective. 

You should already be able draw spaces, 
architecture and objects with two-point 
perspective. You may be familiar with the term 
‘isometric’ or could recognize work executed 
that way. For this project we will explore both 
kinds of representations.

HAND-DRAWN ILLUSTRATION

STEP ONE—Study and Describe 

Using the assigned object in class you will draw it from 

multiple angles and personalize it. Either make a self 

portrait or create an original character. 

In order to illustrate the object, you need to study it 

carefully. Take photographs from different views and 

of the details. Write a brief description of your object 

noting the following:  

• materials   

• textures and surfaces 

• coloring 

• major shapes 

• transitions between major shapes   

 

STEP TWO—Exploratory Drawing/Sketches 

Make sketches exploring your object and the forms of 

it. Draw details on a larger scale. Experiment with both 

perspective and isometric views. Use pencil and fine 

point black marker or pen.

STEP THREE—Drawing Projections 

After completing Steps One and Two, you should be 

familiar enough with your object to create four refined 

drawings of your object. 

The four drawings will include a Front View, Side 

View, Top (or plan) View, and either an Isometric or 

Perspective three-quarter angle View.  

Your drawings need to be large enough to include 

details. Use the same scale and make the front/Side 

Views 4 or 5 inches tall. Add detail and colors with  

fine-tip and broad-nib markers AND/OR colored 

pencils. Work to represent textures and material.
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DIGITAL TRANSLATION  
 
STEP FOUR—Digitizing your Drawings 
Scan your four finished drawings into the 
computer and set each as a Template layer in 
Adobe Illustrator. On new Layers, begin to use 
the Illustrator Tools to build the three views of your 
object. Use your drawings and photographs of 
your person as a guide to recreate the actual 
details of form and the modifications you are 
making.

Take screenshots of your work as it is being 
developed—try for one screen shot every half 
hour to document your progress. Save these 
screenshots in a folder labeled ‘Project1_
Screenshots’ in your Project 1 folder on the class 
server so you will have access to them later to 
add to your class workbook. 

Your finished illustrations should replicate the 
shapes, colors and textures of your object and 
present the personalization your devised to go 
with your character. YOUR CHARACTER NEEDS TO 
BE ORIGINAL.

WORKFLOW 
a) Use separate Illustrator files for each view of 
your object/character.

b) Create Folders to organize your Layers for the 
different levels on each of your illustrations. 

c) Build major shapes of the body first. Work with 
Gradient, Gradient Mesh, Paint Brush tools to add 
shading and highlights. 

 

STEP FIVE—Organization of Final Presentation

ARRANGING VIEWS  
When all four views of your object are completed 
them on one single 11 x 17 inch Artboard in a 
NEW Illustrator document.  When placing your 
illustrations do not crowd them together, but 
make sure there is sufficient room between views. 
Consider how the images on the page will create 
a visual hierarchy. Also, maintain a .75 inch 
margin around all sides of the Artboard. 

LABELING VIEWS 
Using 10 pt. Helvetica Regular, label each view:  
Front View, Side View, Top View, Three-quarter or 
Perspective View. 

NAMING YOUR CHARACTER 
Choose a name for your character. Select a 
typeface that epitomizes the personality of your 
character and set the name in this typeface. 
The character name should be approximately 
3 inches wide. Place it in the lower right hand 
corner of your Artboard.

PRINTING & MOUNTING 
Using the color laser, print your final file on a single 
sheet of Tabloid-size paper. Mount this sheet to a 
black matte board so that 1 inch of board shows 
around all four sides. On the back of the board 
print your name, class number and section.

DOCUMENTATION / ARCHIVE 
Your ‘process’ (drawings, scans, notes, 
screenshots) and final work needs to be archived 
and represented in the Project section of your 
class workbook.

Save your final Illustrator file for Project 1 as a 
native .ai file as well as a .pdf file. Store copies of 
the files in your Project 1 folder on the class server 
using the class naming convention. 

DROPBOX 

PROJECT 1 | TECHNICAL ILLUSTRATION 	   							                 page 2
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PROJECT 2   8-Page Brochure

This brochure will be an informational and a 
promotional piece for the area or group. Think 
of ths as an opportunity for you to investigate a 
subject of interest to you, not just something you 
already know about. 

CONTENT for Brochure  
The TEXT is to be obtained from online sources 
and/or interviews with people involved.  
The IMAGES are to be your own original 
photographs.A loose template will be provided 
for you to follow. Your brochure will be created 
in Adobe InDesign and produced as a printed 
piece as well as a PDF for the web.

PROCESS  
1. Research and Collect Information 
Choose your subject. Investigate the area or 
group online and collect as much information 
as you can. Reach out to at least one professor, 
student, administrator, or other person involved in 
the area and interview them for a quote. Put it all 
into a Word document. 
Visit the physical space, rooms and observe 
the activities. Take notes and perhaps some 
preliminary photos.

2. Take Photos 
Use a fairly decent camera when you go to 
take your photos. Take more photos than you 
think you will need. Set your camera to take the 
highest quality/highest resolution. Remember to 
check your WB. Make sure to take the following:

a) Photo(s) of main person(s)—administrator, 
officer or staff in the area or group.

b) Photos of materials, tools, textures found in the 
space or related to the area or group.

c) Photos of the place, the building and of 
activities taking place there.

3. Review content / build paper dummy 
Review what you have for text and photos. 
Consider the flow of information from the front 
cover through to the back cover and divide up 
the content in a way that makes sense. 
Remember the brochure is meant to promote 
the area or the group. The front cover should be 
eye-catching and carry the university logo. The 
back cover needs to identify the subject (area or 
group) and the university.  

4. Design your Brochure  
Using the template provided, develop concepts 
for your promotional brochure. 

Draw thumbnails for 4-5 ideas for the the front 
cover and sketch several options for your pages 
and back cover. 

Refine your best idea and create sketches for 
the placement of your text and image(s) for all 
pages of the brochure.

5. Work the Visuals  
Use Photoshop to make needed adjustments 
to your photographs. At least one photo will 
need to make use of an object cut out of a 
background using Photoshop.

6. Build your Brochure 
Once you have a strong design comped out 
on paper, build your brochure in InDesign. Set 
your Page Size to be 5.25 x 8.25 inches. Your 
document needs to have Bleeds. Place your 
visuals according to your comp.

7. Work the Typography  
Use appropriate (readability!) typefaces to 
create good typographic hierarchy and strong 
design layout. 

Develop and apply Paragraph and Character 
Styles for the different sections of text you use.  
Follow the guidelines with the Template.

For this project you will research, design and build a 
brochure for a specific area, department or organization 
on the UW-Stevens Point campus. 
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PROJECT 2   8-Page Brochure — continued

8. Save/Package/Export for Print and Web 

Finalize and Save your brochure as native 
InDesign (.indd) file. Package to collect all files 
associated with the document.

 
NOTE: The Template along with specifications for 
the brochure will be provided on Basecamp.

Detailed instructions for preparing PDFs for 
Printing and for the Web will also be provided. 

PROJECT 2  	 Calendar
 

	 tuesday 	 11/10	 introduction 

	 thursday 	 11/12	 hand-out / choose subject

 

	 tuesday 	 11/17	 have initial research, info collected in Word doc // start paper dummy

	 thursday 	 11/19	 have paper dummy, some photos taken // work on project 

	 tuesday 	 11/24	 have ALL photos taken, initial thumbs for layout sketches // start design 

	 thursday 	 11/26	 NO CLASS — ‘Turkey Day’ 

	 tuesday 	 12/01	 have ALL content in InDesign — PDF in-progress crit 

	 thursday 	 12/03	 have refined PDF uploaded to Basecamp // print B&W version 

	 tuesday 	 12/08	 have B&W printed brochure

	 thursday 	 12/10	 Project 2 FINAL DUE // critique 
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PROJECT 2 | Toy & Booklet 

 

PROJECT OVERVIEW 

In this project, you will be planning, illustrating, constructing and promoting original paper-craft 

characters.

 
LEARNING OBJECTIVES 

• Refine Illustrator drawing/illustration skills  • Apply InDesign publication skills to a new format 

and layout challenges  • Practice photography and Photoshop image adjustment techniques  • 

Practice craft and building skills  • Learn 2D 

patterning skills for the creation of a 3D object  • 

Develop diagramming and  

graphic communication skills  • Flex creative 

muscles and build skills in 3D visualization

RULES

1. Develop a unique original character! 

This means it doesn’t already exist through some 

other IP (intellectual property). There are lots 

of templates out there, but it is not enough to 

make simple changes to existing templates. 

Challenge yourself to make your character 

unique.

2. Draw on paper first, then use Illustrator! 

After getting an idea of how to make papercraft 

creatures, plan your own design. Yes, you are 

required to sketch on paper before diving into 

the computer and Illustrator.

3. Size Matters! Claim your work! 

All character templates must fit on 8 1/2 x 11 

paper. Include your name on the template.

4. Craft Counts! 

For critique, you must have your character cut 

out, folded, and glued to display.  

5. Name it with a typeface to match personality! 

At some point you will find a name for your 

creature. Choose a typeface or hand-draw your 

own for this. Think of the name as a logo. 

6. Instructions are Key! 

Your character will be portrayed with instructions 

for cutting, folding, and gluing him/her/it 

together. These instructions need to have text 

and diagrams showing step-by-step how to build 

your creature. Think IKEA instructions.

7. Take Good Photos and use Photoshop! 

Carefully build your character, then photograph 

it from three angles:  front, side, and one 

perspective view. Make sure to White Balance 

your camera and use a neutral background. 

Color correct and make adjustments as needed 

to your photos. Use Clipping Paths to cut out 

the background of at least one photo. Finished 

images should be 300 dpi, 4 x 6 inches, CMYK, 

and Saved in tif format.

8. Plan on paper first, then use InDesign! 

Design an 8 page booklet for your creature. Your 

booklet should have a front and back cover, the 

creature’s name, your template with instructions, 

a brief biography of your creature, and the 

photos of your finished model to show what it 

looks like when put together. Include your name 

and the date or year somewhere on the back 

cover.  

EXAMPLES 
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Check out the sites below for examples of papercraft creatures and their templates:

• www.3eyedbear.com/ 
• pepetz.com/  
• www.macula.tv/papercraft/ 
• blog.spoongraphics.co.uk/tutorials/create-a-flat-pack-toy-the-making-of-frankenspoon 
• �www.yebomaycu.com/index.php?page=ye-bot-initiative

FINAL PRODUCTS 

Physical Things 
• One fully built papercraft creature —well crafted original design in color 
• �One printed copy of booklet  

�BOOKLET SPECS:  �Page size: Letter, Number of pages: 8, Paper size: Tabloid 
Printed: two sides, Front to Back (head to head), Inks: 4-color, Beeds: none 

Finishing: (no trim needed), 1 fold, saddle-stitched (stapled)

Digital Things

• Illustrator file (.ai) for the creature template with the instructions 
	 >> LastnameFirstinitial_ART211_2013_Creature.ai

• PDF file of the creature template with the instructions   >> LastnameFirstinitial_ART211_2013_Creature.pdf

• Packaged InDesign folder of the finished booklet  >> LastnameFirstinitial_ART211_2013_CreatureBooklet

• PDF file of the finished booklet   >> LastnameFirstinitial_ART211_2013_CreatureBoolet.pdf

• Three (3) photographs of finished creature (see rule 7 for details)  
	 >> �LastnameFirstinitial_ART211_2013_Creature_front.tif 

LastnameFirstinitial_ART211_2013_Creature_side.tif 

LastnameFirstinitial_ART211_2013_Creature_perspective.tif

Document in Workbook 
• Sketches 
• Screen shots of Illutrator Progress 
• Screen shots of InDesign Progress 
• Final photographs of your built creature 
• Photographs of finished booklet/layout  
• Any other things worth including

￼￼￼￼￼￼

ART 211  PROJECT 2 | Toy & Booklet

Calendar for Project 2

	 tuesday 	 10/29	 introduction to project 2 

	thursday 	 10/31	 have:  design completed for your creature / build template 

	 tuesday 	 11/05	 have:  first creature dummy printed, cut out and taped together 

	thursday 	 11/07	 have:  instructions begun, refinements to creature dummy made  

	 tuesday 	 11/12	 critique—have:  final color creature printed, cut out and glued together 

	thursday 	 11/14	 have:  photos of creature completed / booklet layout on paper 

	 tuesday 	 11/19	 have:  1 photo cut from background / booklet layout in InDesign, text, photos 

FPO 

	thursday 	 11/21	 have:  all instructions for building creature completed / printed booklet in B/W, 

folded 		  tuesday 	 11/26	 have:  revised booklet, with all content printed in B/W, folded 

	thursday 	 11/28	 — no class — Thanksgiving observed — 

	 tuesday 	 12/03	 final critique—have:  final printed booklet in color, folded, stapled



ART 211 Graphic Design Production I — Fall 2016 — Hoover

ART 211 Graphic Design Production I 
PROJECT 2 | Toy & Promotion Brochure 

WHAT’S NEEDED FOR FINAL:

Physical things

● one fully built toy

● one printed copy of brochure

● one mounted print of logotype

Digital things

 �Photographs/Scans of toy building process:  
...Toy_Process01.jpg, ...Toy_Process02.jpg, etc.

 �Three really nice photographs of finished toy:  
...Toy_front.tif, ...Toy_side.tif, ...Toy_perspective.tif

 �Illustrator files (.ai) for the logotype:   
LastnameFirstinitial_ART211_2012_Toy_Logotype.ai

 �Packaged InDesign folder of the finished 
brochure:  
...Toy_Brochure.indd  

(Foldercontaining Links, Fonts and InDesign file)

 �PDF file of the finished booklet:  

...Toy_Brochure.pdf (Smallest File Size)

Documentation needed in Workbook   
▲  sketches for several toy concepts 

▲  in-progress photos of toy building process 

▲  final photographs of toy 

▲  screen shots of InDesign progress 

▲  photographs of finished booklet/layout 

▲  anything else worth including

	  

	

	CALENDAR 

	 monday 	 12/3	� Project 2: Final due / present toy and brochure to class 

Lesson 23: Binding options 

Lesson 24: Page Numbering / InDesign 

WORKBOOK: Work on design / Choose binding

	wednesday 	 12/5	�Review: Styles, Tabs and other concepts in InDesign / list questions for monday 

WORKBOOK: Prepare files for printer / Print dummy; deliver to Printing & Design

	 monday 	 12/10	� Lesson 25: Digital archiving 

Review: Q & A, sharing, reviewing print production concepts

	wednesday 	 12/12	 WORKBOOK: PRINTED FINAL DUE // Presentations // Self-Assessment 
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ART 211 Graphic Design Production I 

PROJECT 2 | 8-Page Brochure
 
	 Goals for this project:

	 • increase research skills — learn about an organization 
	 • work with Readers Spreads and Printers Spreads 
	 • set up a grid and design according to specifications 
	 • develop conceptual/formal photo skills  
	 • build familiarity with Photoshop as a tool 
	 • create a multipage, saddle stitched booklet 
	 • prepare print document with Bleeds to send to Printer

PROJECT REQUIREMENTS

You need to research the organization or group and gather information and 
content. This includes reaching out to someone in charge to get background 
information and any permissions needed for photos.

Your brochure needs to have:

1.	 TEXT to be gathered or harvested from online sources. You must include: 
the title or name of the organization or group, an intro blurb, a statement/
section on its history, info about the who, what, where, when, why, at least 
one quote or testamonial. Credits for design, photos, printing.

2.	 VISUALS must use your own original, self-generated photographs that support 
the content of the brochure. Photos of places or people or events must 
have captions. All photos need to be at proper resolution for printing, color 
balanced and thoughtfully included in the layout. One of your photos must 
utilize a Clipping Path or Mask in Photoshop. 

3.	 SPECS for your InDesign files need to follow the specifications and directions 
provided, including setting up the Document, Master pages, Grid structure, 
Margins and Columns and Guides. (Screenshots below are for file set up. 
Additional directions for preparation for sending to the Printer will follow.)

4.	 The UW-Stevens Point logo on the front or back cover. (Provided)

Pages Panel in InDesign showing  
Master Pages selected for ssetup.

Setting up the Grid structure on the Master Pages 
using Margins and Columns and Create Guides.Document Setup in InDesign showing specs for number 

of Pages, Page size and .125 inch Bleeds.

BROCHURE DOCUMENT SET UP 
SPECIFICATIONS
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ART 211 Graphic Design Production I 

PROJECT 2 | 8-Page Brochure
 
Steps for Preparing B&W Dummy for in-progress critique

1. Save InDesign file with class naming convention.

2. Package file to ensure all links are current and in the same place.

3. Use Print Booklet to generate Printer’s Spreads in a Postscript (.ps) file.

4. Use Adobe Acrobat Distiller to convert .ps file into .pdf file.

5. �Open the .pdf in Acrobat Pro and print in grayscale to the  
B&W Laser printer on Letter-size paper.

6. Tape correct pages together back-to-back.

7. Fold and trim with an x-acto.

8. Use longneck stapler to bind.
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ART 211 Graphic Design Production I 

PROJECT 2 | 8-Page Brochure
 CHECKLIST
Content / Tech Specs
GENERAL FILE SPECS

•	 8 pages in document
•	 Grid set up on Master page
•	 Adequate margins on page edges
•	 Content follows the grid
•	 Uses Bleeds (set up correctly)
•	 File uses class naming convention
 
COPY (Text Information)

•	Paragraph/Character Styles defined
•	All text has P/C Styles applied
•	Appropriate typefaces used for body
•	Type and Leading sized well
•	Type hierarchy used

IMAGES (Photos/Illustrations)
•	All images in CMYK or Grayscale
•	 Images Saved as .tiff or .eps
•	Photos are color corrected, not distorted
•	 Images saved at size, correct resolution
•	One Image uses Masking 

What to Upload
A COMPRESSED FOLDER 

	 containing...

1. PDF files in Printer Spreads. 

2. �Packaged File from Indesign 
(no warnings/errors)  
File must use class naming convention 

 
3. �Folder with your original photographs and 

illustrations used in your final brochure.

4. �Word document with your research, 
collected information and quote. 

UPLOAD  
compressed Folder to Basecamp before:

   �Thursday, December 10 
   (Wednesday before midnight)

   �You’ll get Bonus Points  
for uploading before noon on  
Wednesday, December, 9!
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 ART 211      Graphic Design Production I
		       End of Semester Calendar

	 day	 date	 what we are doing in class				    what you need to do next

	 thurs 	 12/03	� Project 2 8-PG Brochure:  in-progress crit			    
Print B&W dummy, trim and staple			   FOR TUES > P2: refine your brochure design

			   WORKBOOK: DA 24 Preflight, discuss TOC		  FOR TUES > �WKBK: add any questions you have 
to Basecamp discussion on Wkbks.

	 saturday 	 12/05	� REAL WORLD  great opportunities to hear from uwsp GD alumni			    

	 tues 	 12/08	� Project 2 Brochure:  prepare PDFs for Printer		  BEFORE THUR > �P2: upload Compressed Folder 
containing, Packaged Brochure, 
PDFs in Printer Spreads for Printer  

			   WORKBOOK: covers & guts, address any issues	 FOR THUR > WKBK: refine as needed 

	 thurs 	 12/10	� WORKBOOK: address issues, refine work		  BEFORE  
							       FRI NOON > �WKBK: upload Compressed Folder 

containing, Packaged Files for  
Covers and for Guts, and PDFs of  
single Pages for each.

	 tues 	 12/15	 Presentations of 8-pg Brochures & Workbooks  ///  Self-Assessment & Course Evals  

 
 

	 thurs 	 12/17	� F INALS MEETINGS  TIMES: 9am–11am & 1:30pm–3:30pm	   

Sign up on DKB Hoover’s office door for Individual Meetings  		    		  	  

			   for the remainder of december through january 24, 2016 
				    ...have a wonderful, productive, relaxing, rejuvinating break!
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TYPEFACES: TEXT VS.DISPLAY

Q: �How can I tell the difference between a text font and a display font?  
Are there any rules for their use?

A: 	 There are two primary categories of type: text and display.  
In general, text type is designed to be legible and readable at small 
sizes. This usually implies fairly clean, consistent, uncomplicated 
design features; more open spacing than a display face; and 
strokes that hold up at smaller sizes. 

Display type, on the other hand, can forgo the some legibility 
and readability needed for long blocks of text in exchange for a 
stronger personality and more expressive shapes...in the letterforms.

* * * * *

Typefaces look different depending on the size at which you view 
them. Spacing, proportions, and design details change optically. 

A text face that looks beautiful at 10 points can appear clunky, 
heavy, and unattractive when used at large sizes. Display faces are 
designed to be used as headlines. At small sizes the features that 
contribute to their personality inhibit readability.

Rules:  
Avoid using Display faces for running text.  
Choose display faces to use for headlines, pull quotes, etc. 
Always see how a typeface looks at the size you plan on using it.
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TYPEFACES: TEXT VS.DISPLAY

The best text typefaces are easy to read in long blocks of copy. They 

do not call much attention to themselves and have been designed 

to perform best between 6-point and 14-point. Conversely, display 

typefaces are used to entice a reader into text copy, to create a 

mood or feeling, or to announce important information. Sometimes, 

they accomplish all these purposes at the same time. They are 

intended to stand out, and they perform well when they are used 

appropriately. However, display typefaces can look peculiar in 

applications where text typeface designs are warranted.

DIFFERENT DESIGNS FOR DIFFERENT SIZES

Type and typography are visual media that are very much affected 

by size. In metal type, almost every point size of a given typestyle 

had subtly different proportions. In serif typefaces, for example, the 

thin parts of a character became proportionally heavier as the point 

size decreased. If they had been left the same weight as larger sizes, 

the contrast between thick and thin would have been too great, 

causing an effect called “dazzling” which makes text copy difficult 

to read. The lowercase x-height is also generally larger in text sizes 

than in display designs, and serifs are more pronounced. In addition, 

inter-character spacing is more open in text faces. All of these 

characteristics optimize the typeface for reading at small sizes.  
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LYNDA.COM VIDEO TUTORIALS

BEFORE INDESIGN

Using Word and InDesign Together 
with Anne-Marie Concepción

1. InDesign and Word Formatting Essentials 
	 Discovering how text styles work in Word 				   7m 12s   
	 Understanding the basics of InDesign text styles (for Word users) 	 4m 42s  

INDESIGN OVERVIEW

InDesign CS6 Essential Training  
with David Blatner	

1. Adobe InDesign:		  What is InDesign? 	 1m 23s   
3. Creating a Document:		  Creating new documents 	 7m 39s  

Page Layout 			  InDesign Typography	 8h 20m	

Dissects the anatomy of a typeface and defines the vocabulary of typography, using practical, 
real-world examples in InDesign. 
Nigel French, Intermediate

ILLUSTRATOR

InDesign CS6 Essential Training  
with David Blatner	

1. Adobe InDesign:		  What is InDesign? 	 1m 23s   
3. Creating a Document:		  Creating new documents 	 7m 39s  

	



FOR INSTRUCTORS 
 
General Design & Process Concepts
Formats, typical sizes, common printing options for printed pieces

Describing various analog and digital methods of working and moving 
between them. 

Importance of clear and consistent naming conventions, file 
organization, folder hierarchy, archiving, server usage, MyFiles and 
general asset management. 

Explaining file types, software versions – native files and specific file 
formats, extensions – .tif, .psd, .jpg, etc. 

Different units of measure, Digital Precision / Craft 

 
Critical elements in digital work for Print

• Resolution:    Defining dpi and ppi 
			             Flat Graphics, Photographs and scanning

• Color Space and Color Concepts:  
	 Differences between and uses for RGB, CMYK, and spot color  
	 Color separations 
	 Pantone Matching System 
	 Color balancing photos 
	 Managing color space in a project 

• Output: 
	 Types of printers, laser/toner, inkjet/inks, offset printing 
	 Preparing files for Print 
	 Shifts from screen to output device

• Marks & Bleeds: 
	 What are Marks & Bleeds? 
	 How to create Marks & Bleeds

• Essential features to know and work with in all software applications:  
   Units, Rulers, Guides, Grids, Snap To, Zooming, Key Commands, etc.

Design Software Application Skills 

INDESIGN Demonstrate the ability to: 

o	 Perform basic typesetting, use the type tools, choose fonts from 
font lists

o	 Develop and Apply Style Sheets for Character and Paragraph

o	 Build and Apply Master Pages in multipage project

o	 Produce Printer Spreads and Reader Spreads 

o	 Set Bleeds and Printer Marks

o	 Prepare digital proofs (.pdfs) for clients

o	 Preflight and Package a project for Print production

 
ILLUSTRATOR Demonstrate the ability to: 

o	 Create New Files for specified projects

o	 Setup and change Document Setup: Adjust Artboard size, number

o	 Find and Use most common Tools 

o	 Use the Pen Tool and work with Anchor Points

o	 Work with Scissors, Knife and Pathfinder

o	 Apply Gradient, Gradient Mesh

o	 Use Layers effectively, organize, 

o	 Apply Filters and Effects appropriately

o	 Work with Live Trace and Tracing Options 

o	 Save and Export illustrations in varied file formats

Photoshop Demonstrate the ability to: 

o	 Open and Assess photographic Imagery

o	 Identify and Use most common Tools

o	 Work with Layers effectively

o	 Choose and Use Selection Tools – Wand vs Lasso vs Paths

o	 Perform Image retouching 

o	 Apply Cloning and Patching Tools 

o	 Create Silhouette and Vignette 

o	 Use Sharpening and Blur Tools

o	 Make use of Adjustment Layers: Levels, etc.

o	 Adjust Color Balance, Hue/Saturation, Color Replacement

o	 Create Masks

o	 Make and Save Clipping Paths

o	 Incorporate Type into file

o	 Apply Filters and Effects appropriately

o	 Save and Export images in various file formats for intended target 
application 

Acrobat Demonstrate the ability to: 

o	 Create PDF from files 

o	 Portfolio options 

o	 Incorporate Type into file

Content creation, manipulation and page assembly using 

Adobe Photoshop, Illustrator and InDesign. Learning Goals are 

focused on recognizing the appropriate software for particular 

tasks—specifically, identifying the differences between single 

page illustration software and multipage layout software, and 

between Illustration and Photography software. Additional 

goals are demonstrating the ability to prepare design work for 

print and integrating the applications.

Craft for Graphic Designers

Using a ruler, straight edge, T-square, measuring for mounting, 
cutting matte board

All about cutting:  x-acto, utility knife and shearing techniques

Mounting, creating presentations

Learning pen and marker techniques 

Brochure, booklet, package techniques

Post-Press Operations

Exposure to foil stamp, emboss, die cut, and engraving 

Exposure to binding options and techniques 

Tour Printing and Design

Assessment Methods 

Each student will create an exercise journal for the class 

documenting all assignments and learning activities. Screen 

shots will be used to visually record and each student will write 

a description of the exercise. Format should be fixed. The in-

progress journal will be built using InDesign and will be turned 
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Opinion Survey
 ART 211 GRAPHIC DESIGN PRODUCTION I		

Feel free to use the back of the paper if you need more space to write your answers.

1. �In this class we studied a variety of concepts and procedures associated with print design. You 
worked with the major software programs used in print design and how to use them for specific 
design aspects. You were asked to create solutions for three assignments—1 major multi-page 
publication and 2 smaller projects.  You learned about creating technical illustrations, designing 
in 2D to build 3D dimensional pieces, developing publications for print and how to prepare the 
files for sending to the printer.  

	 a) How did the casual approach in studying the text work for you? 

	 b) Would you have liked to read, write and discuss more about design and design careers?

	 c) Do you think more readings and discussions on semiotics/symbology would be helpful?

2. �In this class we worked through four major design projects: 1–Letterform Marks, 2–3D Transfor-
mation  
(of a Letterform Mark), 3–Symbol Set Creation with Contrasts/Principles, and 4–Symbol Mor-
phology.

	 a) In your opinion, what project was the most effective and why?

	 b) In your opinion, what project was the least effective and why?

3. �Your work as a designer is evaluated on the strength of your concept development and craft 
in the final execution of your design solution. Feedback is given through in-progress and final 
critiques as well as grades and comments. In your opinion was the feedback you recieved in 
this class helpful? Do you have suggestions for how else feedback could be given? 

4. In your opinion what thing or things should the instructor do better? What did the instructor do 
well?



Technical Aspects: 70 possible points

5   4   3   2   1   0	 Complete	 Workbook contains all required content/assignments 

5   4   3   2   1   0	 On Time	 Workbook files prepared and uploaded for printing by due date

5   4   3   2   1   0	 Covers 	 Use Bleeds and set up correctly, have specified copy and UWSP logo

5   4   3   2   1   0	 Pages 	 Designed with No Bleeds, have adequate margins

5   4   3   2   1   0	 Structure	 Title Page, Table of Contents (TOC) are present 

5   4   3   2   1   0	 Master Pages	 Master Page (or None) applied to all pages

5   4   3   2   1   0	 Page Numbers	 Automatic Page Numbers used

5   4   3   2   1   0	 Page Furniture 	 Running Footers or Headers included

5   4   3   2   1   0	 Grid	 Master Pages carry grid, content placement follows grid

5   4   3   2   1   0	 Type	 Text/Display faces, leading, and measure (column widths) good for readability

5   4   3   2   1   0	 Styles 	 Paragraph/Character Styles used, paragraphs indications appropriate

5   4   3   2   1   0	 Images	 Amount of images adequate, labels/captions/annotation used, tiff/eps format

5   4   3   2   1   0	 Color Use	 Cover(s) CMYK, interior pages use Black + 1 Spot only, images Grayscale or CMYK

5   4   3   2   1   0	 Digital Files	 InDesign files: Packaged, PDFs for Covers and Pages, class naming convention used 

Design Aspects: 20 possible points

5   4   3   2   1   0	 Organization 	 Workbook content is considered overall, grid used to create strong cohesion

5   4   3   2   1   0	 Page Layout 	 Page spreads use structure, balance, proximity, white space, rhythm, variety, etc. well

5   4   3   2   1   0	 Image Use	 Creative/informative subjects, framing/cropping executed well

5   4   3   2   1   0	 Type Use 	 Typefaces harmonious, type hierarchy, used well for deliniating areas of information

Content Generation Aspects: 10 possible points

5   4   3   2   1   0	 Text/Writing 	 Quality and quantity of text developed for the workbook including captions

5   4   3   2   1   0	 Imagery 	 Quality of original imagery created for the workbook

WORKBOOK TOTAL: 100 possible points  _________ 
100–96=A, 95–90=A-, 89–84=B+, 83–77=B, 76–71=B-, 70–64=C+, 63–58=C, 57–51=C-, 50–44=D+, 43–37=D, 36–0=F 

PROJECT 1: Technical Illustration (Lego Persona) 
Development of character, Required views presented, Quality of rendering, Craft of presentation, Digital files

15  14  13  12 11 10  9  8  7  6  5  4  3  2  1  0 	 15 possible points  _________

PROJECT 2: 8-Page Booklet (Informational/Promotional brochure) 
Research of subject, Documentation with photography, Interview/Quote used, Required content, Design work, Digital files

15  14  13  12 11 10  9  8  7  6  5  4  3  2  1  0 	 15 possible points  _________

PARTICIPATION  
Investment of energy in assigned work, Daily Assignments, Presence and participation in class

10  9  8  7  6  5  4  3  2  1  0   		  10 possible points  _________

 
PROJECTS & PARTICIPATION TOTAL: 40 possible points  _________ 
40–39=A, 38–37=A-, 36–34=B+, 33–31=B, 30–28=B-, 27–25=C+, 24–22=C, 21–20=C-, 19–18=D+, 17–15=D, 14–0=F 

ART 211 Graphic Design Production I		   

Final Grades 					           NAME

GRADES:   Workbook  _________     Projects / Participation  ________   

 FINAL SEMESTER GRADE  ________

Numbers 5–0 indicate the quality of each project or component including accuracy, visual organization, craft, and/or technical proficiency.	  
5 = excellent, no problems;  4 = good, minor issues;  3 = okay, some problems;  2 = not-so-okay, problems in a number of areas;  1 = bad, very problematic in many ways;  0 = no attempt made 


